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ABSTRACT
This report is the initial User manual for the InfoNMT information resource for non-motorised
transport in NSW. The NSW RTA Non Motorised Transport project has covered the range of
nonmotorised modes, and brought together a range of information resources on walking, cycling
and cyclists. Much of this information has been brought together in a form that can be made
widely available in a useable form. This has been done by constructing three computer
information bases, using standard programs as a starting point to create a customised system
designed and tailored for this type of use. These information bases provide a practical means for
the RTA to continue to capture the information as it grows, and to retrieve information as
required. Two of these databases use Claris FileMaker Pro to deliver information on bicycle
contacts and data resources, and one uses Niles and Associates EndNote to deliver references and
abstracts. This report covers the contact and bicycle data resources, held in FileMaker Pro format
for Windows and Macintosh computers. A companion report covers the references and abstracts
resource (RefNMT: NSW NMT Project Report NMT-94-10). Much could be gained by making
these systems widely available, with the RTA maintaining a growing resource as fresh information
was returned from users across the State. A companion report describes the system as a whole, and
discusses means of making the best use of it (NSW NMT Project Report NMT-94-R5)
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1. INTRODUCTION
The NSW Non Motorised Transport Project at ITS, University of Sydney, has reviewed a very wide
range of information sources for bicycle and pedestrian analysis. Many of these are not readily
accessed by people wishing to work in the areas of bicycle policy and planning, and a summary of
the major resources identified is one of the valuable and useful deliverable products from this
project.
This report is a User Manual for the databases (named InfoNMT) built to make access to this
information easier for people with an interest in NMT, and to provide some summary context
information on the nature and utility of these data sources. A companion report (NMT-94-R5)
covers the design and contents of this InfoNMT database and the Reference databases (RefNMT)
The present report provides assistance to people wishing to use the databases, and to extend their
initial coverage.
This Manual is organised as follows:
•

What does InfoNMT do?

•

Computer and software requirements to run InfoNMT.

•

Exploring InfoNMT without a manual.

•

Using InfoNMT.

•

Reference specifications for InfoNMT facilities.

•

Useful special features of Filemaker Pro.

2. WHAT DOES InfoNMT DO?
InfoNMT is a set of information bases that run on IBM PC - Compatible Computers, under
Microsoft Windows, and Apple Macintosh Computers. It contains information about a number of
different bicycle and pedestrian data sources. This information can be searched in several ways.
InfoNMT also offers assistance in establishing and maintaining contact with holders of
information and expertise. Entries can be added or existing entries can be modified to extend the
range of contacts covered and the data sources included.
Institute of Transport Studies - Sydney
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InfoNMT contains two different types of data:
• Contact information (which can include interview notes as well as address and contact details)
• Specifications of data resources which include information about cycling, cyclists, pedestrians
and walking. Details of the context in which this information is held are given, and
commentaries are provided on the quality, usefulness and structure of this data. Instructions
are given on how to access the information, and the forms in which it may be made available.
InfoNMT is normally accessed by starting Filemaker Pro and opening the "Contacts.Nsw" or
"Data.Nsw" files which will then load the Contacts or Data database ready for use. There are two
strategies available to begin a search for information:
1.

Start by looking for individuals who are knowledgeable in the appropriate area. Open the
Contacts database and search for appropriate contacts. Each contact may be the person who
can advise you about one or more data sources, and you can move to examine the list of data
sources that they hold.

2.

Alternatively open the data database and search for a suitable data source. When it has been
located you can go on to examine the details of the appropriate contact.

To aid in follow up of the information held by a particular person or organisation, InfoNMT
contains preset letter, fax and label layouts, and operates a contact and call tracking system so that
the progress of enquiries is always available within the system. New contacts and additional data
sources may be added.
InfoNMT provides a self contained method of searching for information and monitoring your
progress in obtaining it. Facilities are provided to identify the name and contact details of users
entering new records or modifying existing records in InfoNMT. New or modified entries can be
extracted and forwarded to the RTA to allow update of the master information base.

3. COMPUTER AND SOFTWARE REQUIREMENTS TO RUN InfoNMT
InfoNMT is written in the database program Claris FileMaker Pro 2.1. This program was chosen
for its relatively low price and ease of use and because the same database files run equally well
under Microsoft Windows (version 3 or higher) and on the Apple Macintosh. Consequently only a
single version of the InfoNMT databases is required. A Macintosh computer was used to develop
the system, and the graphics included in the InfoNMT database are from the Macintosh.
Institute of Transport Studies - Sydney
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InfoNMT has been designed to give access to all features of Filemaker Pro, not just those used by
the database. The additional capabilities are documented in the Claris manuals (Claris Corp.,
1992a,b) and the design of InfoNMT has been kept in the general spirit of these manuals.
However neither prior knowledge of Filemaker Pro nor reference to the manuals should be
needed to operate InfoNMT.
3.1 System requirements for Stand Alone usage:
A colour Macintosh with at least 4 mb of memory is recommended, It is possible to run InfoNMT
without a colour screen. The InfoNMT files are too large to be run from floppy disks. A
minimum of 5 mb of hard disc space is required for the files plus an additional 6Mb for
Filemaker Pro. A total of 15 Mb is recommended if the companion database (RefNMT: (Wigan &
Smith, 1994) ) is also to be loaded.
The requirements are very similar for IBM PC compatible computers. A minimum of 4mb of
memory and a copy of Windows 3.1 or higher version is required to run Filemaker Pro. 8Mb of
memory is recommended due to Windows memory requirements and a colour VGA screen is
desirable. Hard disk requirements are a minimum of 6Mb for the InfoNMT files and an estimated
7 Mb for Filemaker Pro.
3.2 System requirements for network usage
Only one copy of the InfoNMT database files is needed. They can be accessed across a network
by Filemaker Pro running on either Apple Macintosh or an IBM PC Compatibles. Network
printing is supported by both machines. Several users can access the databases at the one time but
cannot make changes whilst more than one machine is connected to InfoNMT.
3.3 Using a server on a network:
An Apple Power PC server version of Filemaker Pro has been released, and a Microsoft Windows
version is due for release. These server versions are very fast.
3.4 Stand alone use without a copy of Filemaker Pro:
Runtime only versions of InfoNMT could be produced if required, but such versions could not be
updated and would be irritating to uses since a users password would be needed frequently during
a session. As the program is inexpensive, it is more appropriate that a copy of Filemaker Pro 2.1
be obtained.
Appendix 1 has instructions for installing InfoNMT on an IBM PC compatible computer and its
companion Appendix 2 contains installation instructions for the Apple Macintosh.

Institute of Transport Studies - Sydney
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4. EXPLORING INFONMT
Few people want to read a manual before trying out a new program. This section contains the
minimum guidance to get started and explore what the information base offers. The rest of this
manual explains how to use the features of InfoNMT in detail.
These instructions assume the following:
1) You have a copy of Filemaker Pro installed it on your machine.
2) You have a copy of InfoNMT, and have installed it (Appendices 1,2).
•

The first step is to start Filemaker Pro running by double clicking on the Filemaker Pro
application icon.

•

When Filemaker Pro is running, go to the File menu at the top of your screen and open
the Contacts.Nsw file. InfoNMT will display the entry that was on the screen when
InfoNMT was last used. In the example here this happened to be an entry for Dr Laurence
Knight.

Fig. 4.1 The "front page" of the Contacts database seen when starting InfoNMT
Institute of Transport Studies - Sydney
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When the screen shown in Fig. 4.1 appears, press the Help! button on the top right hand
side of the screen. This will provide a quick summary of the meaning of each of the
buttons on the screen.

•

Click on the Return button, and the front page of the contact screen will appear again.

•

Experiment with the row of buttons at the bottom of the screen. The worst that can happen
is the creation of a new empty record. This will do no harm. A Return button is provided
on each screen that you can reach.
• The Call Log button will take you to another database, one designed to track contacts.
Return from this by clicking on the Go to Contacts and Return to Contacts buttons until
the first screen you saw (Fig. 4 1) reappears.

•

If you have not already done so, click on the Call Log button to explore the call logging
and tracking database. The screen you will reach is shown in Fig. 4.2.

Fig. 4.2 InfoNMT advising is contains no previous call contacts for Dr Knight
As InfoNMT cannot find a previous entry for Dr Knight, tell InfoNMT to continue by clicking on
the Continue option. What is happening is that it is attempting to find a previous contact record
for the contact name you were looking at in Fig. 4.1, and not finding one. It will then create a new
one for you. If InfoNMT had found a previous contact record, it would have gone to the record
and positioned the cursor in the notes field for follow up notes. Click on Add Call to create a new
contact entry.
The information about the contact will appear, and an area labelled Notes will appear in the
middle of the screen (Fig. 4.3). Click in this area and type something. In Fig. 4.3 the words "Here
are some notes for the User manual example" have been typed, and the mouse has been clicked
and held down over the

area. A menu of options appears, and is shown in Fig. 4.3.

There are other examples of this form of menu option in both the Contacts and Data databases,
and the shadowed box indicates where they are. Explore the other options and buttons on this
screen - and the further buttons on subsequent screens.
Institute of Transport Studies - Sydney
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Fig. 4.3 Entering notes and choosing a follow up action with Dr Knight

Fig. 4.4 Finding contacts involving a combination of subject and organisation

Institute of Transport Studies - Sydney
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To search for a particular subject that might have come up in a contact notes, a letter or a fax to
any contact, not just Dr Knight , click on Find Call. The options offered in this dialogue can be
used in any combination. For Fig. 4.4 the abbreviation "GIS" (Geographical Information Systems)
has been placed in the general field, and "Road Safety " in the organisation field.
We may also be interested in items outstanding, so we returned from the Find using the Go to Call
Schedule button- and there is indeed a GIS action outstanding.

Fig. 4.5 Result of a Find search on the Tracking database

•

To explore the Data database, first return to the Contacts database, and then click on the
Go to Data button at the top of the first screen. The screen shown in Fig. 4.6 will then
appear.

•

Click on the Help button to obtain a summary description of the function of each button,
and then click on Return button.

•

Explore the different buttons on the screen. In two cases (Study and Data) there are
additional buttons on the screens that you reach. Clicking on the View References
button on the screen reached by clicking on the Study button will show the references to
reports and papers connected to the particular data resource you are exploring.

•

Under the Data button is a View Graphic button. In a number of cases information has
been obtained which lends itself to a useful graphical display on an NMT aspect of the
data resource concerned. This has been placed on the screen that is reached through the
View Graphic button. Returning to the front page (Fig. 4.6 for the Data database Data.Nsw), the buttons at the top of the screen offer the choices of Quit InfoNMT or
Go to Contacts. Quit will leave the entire program, while Contacts will take you back
to the screen shown in Fig 4. 1.

Institute of Transport Studies - Sydney
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Fig. 4.6 Data database front page for one of the studies in InfoNMT
•

Quit InfoNMT by clicking on the button with this name at the top of the screen.

5. USING INFONMT
This section is concerned with the effective use of the InfoNMT database as a whole. Section 6
contains the full reference specifications of the different screens that appear, with explanations of
the various buttons and facilities offered.
5.1 Finding information in InfoNMT
No database containing contact information can remain static, and changes are inevitable. This will
include deletions and additions as well as changes to the contacts in the system over time. However
the contacts connected to data sources will remain valuable, as the person will retain at least some
knowledge of the data even when the responsibility for the data source has changed.
The InfoNMT database contains about 40 different data resources, and further candidates for
inclusion continue to arise. Not all of the potential data resources that were found could be
included in the initial release of InfoNMT. There are many data sources where the data itself was
not retained, or indeed fully documented. When a reference to a report is all that remains,
information about the report is included in RefNMT the project reference resource database.
Institute of Transport Studies - Sydney
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As more data is collected, the guidelines offered by the examples in InfoNMT can help to ensure
that such data is at least described, and preferably captured, as it is produced. Completing the audit
sections of the data descriptions will usually need some external input, but the basic capture of the
descriptions and details of the information can be put into InfoNMT using the facilities included
in the software. The links between the people with responsibility for the data, and the provision of
space for the details published and unpublished reports will make this process considerably easier.
The process of searching for information in InfoNMT can be done in a variety of ways. One
method is to search for people who have connections with the area of interest. This can be done
by searching for people in a given region, people with a given organisational code (Academic,
Water, Police, Local Government Authority, State Road Authority etc). The Find command is
available in several places within InfoNMT.
Searching the InfoNMT Contacts database(Contacts.Nsw)
Search looks to see if the topic of interest was covered in an interview summary or in the
comments recorded in the database. Several key items of information are used to locate an
appropriate person in the Contacts data base. The program uses these items to search all of the
fields in the database at once, and brings up records where all the fragments, numbers or complete
words can be found at some point in these records.
Searching the InfoNMT Data database (Data.Nsw)
Search for information can also be started from the Data database. In the Data database there
may be a large number of items (in some cases several hundred or more) describing the items in a
survey, for example, and all will be scanned in a Search process. A button at the top of the main
Contacts screen will take you directly to the Data database. If the Data database is searched, and a
resource of interest is located, then the appropriate contact in the contact database can be reached
directly by clicking on the Contact button on the main data database screen.
If no suitable responses can be located in the data resource, then a Search on the contacts data
base may identify an appropriate person or persons. If any of these people have a Yes button
turned on

(as in this example), then clicking on the Go to data

button will take you directly to the data resources for which this person it the contact. There may
be several databases for a single person, in which case all of these would have been selected during
the transfer to the data database.
5.2 Viewing the results of a Data database search
The data resource entries cover a range of different aspects of the data resource. Some of these
will be extensive, others abbreviated, depending on the availability of the information required.
Institute of Transport Studies - Sydney
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Fig. 5.1 Displaying all the data records in a summary list format
When a particular data source (or sources) has been selected, it is useful to click on the List
Layout button on the data database control screen, which produces an easily scanned summary of
all the data sources currently selected. The See all records button on the Data database control
screen will ensure that all of the data sources will be selected before displaying the full list, as
shown in Fig. 5.1.
Clicking anywhere in a particular line will select that data resource entry, and a thin vertical line on
the left hand side confirms this choice. This can be seen on the last line in Fig. 5.1. If the Return
button is used, the control page of the data database will reappear, with the details of this ABS
survey filled in.
This rule applies wherever InfoNMT offers a list display. Entries in the Tracking database can be
selected in this way, so too can entries in lists produced when doing searches of the Contacts
database.
5.3 Exploring the range of information about the data in the Data database
The data database control page contains a succinct summary of the data resource on the screen,
and a great deal of information is contained behind the buttons. Each should be explored, starting
with the block of four buttons labelled "Description".

Institute of Transport Studies - Sydney
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The "Audit" block of buttons covers a range of areas where the quality and relevance of the data
are considered. In some cases these will be brief entries, but under Data there may be a significant
amount of information The Access button contains the details of accessibility of the data itself
(further details of the screens reached via these buttons are given in section 6.2).
Once the details of the data source have been reviewed, the Contact button takes you to a screen
with all the details of the relevant person. Return to Contacts takes you back to the Contacts data
base, and Call Log then sets up an action record and provides the fax and letter formats for
further follow up.
Each of the three different databases inside InfoNMT have their own functions. It is important to
note that when searching for information that Searches and Finds apply only to the database in
use at that time: Contacts.Nsw for the Contacts database, Tracking.Nsw for the tracking database,
and Data.Nsw for the data database.
5.4 Adding new entries to InfoNMT databases
A major function in InfoNMT is the addition of new entries to the Data, Contacts, and Tracking
databases. There are buttons for these tasks in the control screens of each database.
Adding an extra Data database entry requires the Add Entry button. This will present a blank
screen in the format of the Data database control page. An entry will require a name, date of the
data collection and some location details as an absolute minimum, but the entries can be altered or
updated at any time. InfoNMT will automatically enter the date for any modification of the data
record. All fields with a shadowed box around them offer a pop-up menu to speed up selection of
the appropriate description.
A special feature of the Add Entry button in the data database is that the first step is to request the
entrant to insert his or her name and other details. If the entrant had not yet put their own details
into the Contacts data base, InfoNMT checks, and instead of competing the entry on the entry
screen, will transfer to the Contacts data base for entry of contact details.

Institute of Transport Studies - Sydney
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6. DESCRIPTIONS OF THE FUNCTIONS ON THE InfoNMT SCREENS
This section systematically goes through the different screens and facilities in InfoNMT.
6.1 Minor Filemaker Pro screen facilities common to many InfoNMT screens
There are a number of minor features of Filemaker Pro that appear on almost every screen, and
these are covered in the present Section. Some extra facilities are available at any time through the
use of Filemaker Pro commands, these are covered in Section 7.
The InfoNMT screens are the bordered windows entitled 'Contacts.Nsw', 'Tracking.Nsw', and
'Data.Nsw'. The left hand side and bottom borders contain a number of useful facilities.

Top left

Bottom left

Top right

Left in a search

Fig. 6.1 Filemaker controls in the borders of InfoNMT windows
There are two controls in the top right of each screen.
•
•

Clicking the mouse in this box will cause the InfoNMT display to fill the screen.
Placing the mouse on this vertical slider, and holding the mouse button down allows
the position of the InfoNMT display to be moved vertically within the InfoNMT window,
so that parts of the screen that are not visible can be brought into view.

There are three controls in the bottom left border.

•

Clicking on Browse will produce the display shown on the left. Info
NMT operates with Browse set all the time.

Institute of Transport Studies - Sydney
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Access to Find, Layout and Preview can be restricted, but has not been in this version of InfoNMT.
Changing the setting to Preview will show what would be sent to the printer if that screen were to
be printed. If this is used, change back to the Browse setting before proceeding to use InfoNMT as
the buttons and controls will not work in this setting.
Changing to Find will discussed in Section 7, as it changes the screen into a pattern for general
searching of the database, but with none of the assistance provided by the buttons in InfoNMT.
The Layout setting is used to design and change the structure of the database,
and should NOT be used.
•

Placing the mouse on the horizontal slider allows the InfoNMT display to be moved
sideways within the InfoNMT window.

•

Clicking on the small mountain picture will reduce the scale of the display
within the InfoNMT window, and clicking on the larger mountain will expand the scale of
the display within the InfoNMT window.

•

Clicking in this area removes the left hand border from the display within the
InfoNMT window. It is recommended that the border be left visible when using
InfoNMT.

There are two controls in the top left border.

•

The bar to the left of the 'book' can be moved using the mouse to move quickly
through the records. Clicking on the bottom 'page' of the book will advance the display in
the InfoNMT window by one record, and clicking on the top 'page' will move the display
to the previous record.

When carrying out a search or a Find within InfoNMT, the left hand border may show several
options. These are:

•

Clicking in this box will cause InfoNMT to find all records except those
specified by the search on the InfoNMT screen.

Institute of Transport Studies - Sydney
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The normal action is to click on Continue or hit the return or enter key.

6.2 InfoNMT screens for the Data database
The front or master page controls access to the InfoNMT database. All the others can be accessed
from there or, in the case of Documentary References and Optional Graphic for Data Description,
from the Study, Survey or Data Collection Process description and Associated Data Records
screens respectively.

Fig. 6.2 Screens contained in the Data database
Brief descriptions of the contents and purpose of some Data database screens follow:
Records Screen
This contains as much detail as possible about the questions asked, the variables and values held in
computer readable form, and the response value codes used to code data. In some cases this is a
very large amount of information, and in others - especially where now only printed records
remain available - the coverage is limited.
Usage Screen
The reported usage of datasets for bicycle purposes is often difficult to trace. The data holders are
not usually aware of all of the detailed applications of the data.

Institute of Transport Studies - Sydney
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Location Screen
This screen contains the actual areas covered, and any confusing or non-obvious aspects of the
area to which the survey or dataset applied or the data collection process covered.
References Screen
Lists the documentary references , papers presented and reports written which discuss the study:
see Fig 6.3. The references shown are all in RefNMT, the associated reference resource (See
Report NMT-94-R10).

Fig. 6.3 References screen in the Data database
Data Screen
The InfoNMT project was not designed to summarise or analyse the data. The data itself was not
made available for many of the data bases. However, in a number of cases key items of
information were available in reports and in others a concise summary of data supplied proved to
be possible. This screen has been used to give some feel for the type of data held in the dataset.
Graphic Screen
Adds a Graphic produced, where possible, using the data and reports obtained. This has proved in
user tests to be a very popular addition which helps to give some feel for what the data might yield
if it was obtained.
Reliability Screen
The reliability of the information is often not stated in the reports. In a number of cases the
surveys or data collections are of very small numbers of cyclists, but can still yield significant
conclusions. On the other hand, some large scale surveys were done in such a way that it is simply
not possible to generalise.
Utility Screen
The utility of a data resource is a function not only of the reliability and representativeness of the
information collected, but also of the availability or otherwise of any comparable bicycle data.
The areas where the data has either already proved to be appropriate and useful, or the type of
Institute of Transport Studies - Sydney
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contribution it was planned to make, are summarised here.

Fig. 6.4 Data screen in the Data database

Fig. 6.5 An Access (Audit) screen in the Data database

Institute of Transport Studies - Sydney
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Accessibility Screen
Access and availability for the datasets varies widely. In some cases (such as the Federal Office of
Road Safety) the data is made available on clearly defined terms once it has been processed
(which may take one or two years). In other cases organisations letting bicycle contracts had not
required the provision of either a copy of the data or its coding conventions as part of their
contracts. The range of access provisions and status makes this screen an important one to check.
Potential Screen
The potential usage of a given dataset, or of developments or wider usage of the data collection
approaches have been included. Not all surveys or data collections justify entries on this screen.
Policy Screen & Data Synthesis Screen
These screens note where the data set has especially been useful in determining NMT policy and
provide information about transport models or in depth data analyses drawn from the data. The
number of data sets used for either purpose is limited.
Search Screen
Can initiate a search on all text fields. The search procedure (described in section 5)allows
searching on groups of words and /or word fragments.

6.3 InfoNMT screens for the Contacts database
The front or master page shown in fig. 6.6 controls access to the InfoNMT contact database.

Institute of Transport Studies - Sydney
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Fig. 6.6 The list of screens in the Info NMT Contacts database

Fig. 6.7 Data Entry screen: Contacts database

Fig. 6.8 Data Entry Help screen: Contacts database
Institute of Transport Studies - Sydney
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Fig 6.7 is the controlling screen for each entry in the contact database, and contains many features
activated by clicking on the buttons. The Data Entry Help screen Fig 6.8 summarises the functions
available, and is reached by clicking on the Help button on the Data Entry screen.
The Colour Screen button produces the screen display shown in the Fig. 6.7. The B&W Screen
button shifts to a more compact form of screen display which still contains the same information
and control buttons.
Adding Contact Names
Adding names to the Contacts database is done by clicking on the Add Name button. This brings
up a blank new version of the screen in Fig. 6.8 and the details can be typed in. Some fields
require a circular button to be clicked: to choose Yes or No. Preset titles and categories (Fig 6.9)
can be accessed to assist data entry.

Fig. 6.9 Preset titles and Code categories: Contacts database: Main screens
Listing of Contacts
The List button on the front page provides a means of generating lists of contacts. This button
transfers InfoNMT to the screen shown in Fig 6.10. Note that the Display current list; button will
Institute of Transport Studies - Sydney

NMT-94-R6 Page 19

Wigan

InfoNMT: User Manual for the NSW NMT Reference Resource

simply show the current selections in list form. The other buttons will select all the records in the
database, sort them in the manner specified, and show what the list would look like. It is necessary
when using these three buttons to click the Continue button in the left hand border of the
InfoNMT window to proceed from the preview of the selected list.

Fig. 6.10 Choose List: Contacts database
Fig. 6.11 shows the preview stage after selecting the Type button in Fig. 6.10 The divisions - Adv.,
Gov. Bus.: stand for Advocate, Government and Business - are only printed out, and are not shown
on the screen in this form in the normal mode in which InfoNMT operates. The results for
Organisation and contact Code list selection buttons are similar.

Fig. 6.11 Preview List: Contacts database
Interviews with Contacts
The Interview button allows an interview to be typed in directly into the database. The cumulative
value of having letters, faxes and interviews all associated with the contact person record is that
they can all be searched at once to locate people with associations with different aspects of non
motorised transport. If letters and faxes are attached to the Call Log Tracking entries, then it will
be necessary to go to the Call Log database to search the contents.
Institute of Transport Studies - Sydney
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Letters, Faxes and Mailing Aids
The Letter button moves to the Letter screen, the Envelope button moves to the Envelope screen,
and the Fax button moves to the Fax screen. The Labels button moves to a screen offering a
range of different types of labels. In each case the layout can be customised with the letter heads
and logos of the RTA or the user of the copy of InfoNMT. These buttons are useful for
immediate access to an automatically headed letter, fax, envelope or mailing label which can be
customised by (or for) each user.
This screen provides for only one letter and only one fax per contact person. If letters or faxes are
likely to be exchanged over a period the Call Log button should be used to create a new contact
record in the Tracking database for tracking over time.

Fig. 6.12 Letter screen: Contacts database
The basic letter included in this version of InfoNMT appears in Fig. 6.12. Logos and full names,
titles and addresses can be included if required. It should be noted that, unlike the screen display
the printed versions of letters and faxes automatically close up the spaces in the address.
The buttons provided include a spelling checker and a direct command to print a copy of the
relevant fax or letter plus address information. The Print and other buttons visible on the screen
are not printed out when the Print button is used. The Preview setting at the bottom of the screen
can be used to check what would be sent to the printer.
The group of mailing aids is completed by a series of labels. The production of labels is
associated with creating lists and making selections from the InfoNMT database. This can be done
in a number of ways, by using the preset List selections built into the label control screen, by using
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Search or Find screens, or by selecting and sorting lists of groups for whom labels are required.
Assuming that a selection of a single person has already been made using one of these methods,
then clicking on the Labels button on the main control screen (Fig. 6.6). will produce the labels
dialogue Fig. 6.12.

Fig. 6.12 Labels dialogue: Contacts database
A label type screen appears allowing choice of type of label, for example those shown in Fig.
6.13.

Fig. 6.13 Layout of A4 sheet labels as preset in InfoNMT: Contacts database
6.4 InfoNMT screens for the Tracking database
If letters and faxes are attached to the Call Log Tracking entries, then it will be necessary to go to
the Call Log database to search the contents. The list of screens in the Tracking database are
shown in Fig. 6.14.

Fig. 6.14 Screens contained in the Tracking database
The major facilities in the Tracking database are held in the two screens: Call Log and Callback
Schedule. The Letter, Envelope and Fax screens are very much the same as those in the Contacts
database (and will also need similar customisation for particular users to gain the full benefit from
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using them).
The Tracking data base is shipped with only example entries as its purpose
is to provide contact tracking facilities for the user.
7. USING FILEMAKER PRO FEATURES FROM WITHIN INFONMT
InfoNMT is written in Filemaker Pro, and is run under its control. This means that there are many
facilities within Filemaker Pro that can be used as extensions of InfoNMT.
The minor features of Filemaker Pro that are intended to be used by all database users have been
described in Section 5. These are simply functions of the Filemaker Pro display, and include both
the 'book' and 'bookmarker' which can be used to scan through records, and the Continue button
in the left hand margin.
Additional Filemaker Pro commands are available from the menus at the top of the video screen,
(above the InfoNMT screens). InfoNMT has been designed to allow a user to avoid these
commands. There are also some of the special facilities available in the left hand border of the
InfoNMT screens when searching for information or importing and exporting sets of data
records.
7.1 Using the Filemaker Pro Sort command

Fig. 7.1 Complex Sort in the labels Dialogue screen: Contacts database
View as a List button on the front page of the Contacts database displays all the records then
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selected as a list - but also offers the option of sorting them. The Sort button gives immediate
access to the sorting facilities in Filemaker Pro. This command can be invoked from Filemaker
Pro at any time on any screen without a button by using the Sort command under the Select menu
at the top of the screen.
This sorting dialogue gives access to many fields in the database that are not immediately visible to
the end user, but as the data fields are reasonably descriptive, a special sorting order can be built
fairly readily. The process is to Clear All first, select the data type in the left hand window on
which you wish to base the sorting process, and then click on the Move button.
7.2 Add New Record Filemaker Pro command
This function can also be invoked by using the New Record entry under the Edit menu at the top
of the screen in place of the New Contact button in the Call log Tracking database. It is not
recommended that this be used in the Data database as the Add a Record button in the data
database also manages the input of contact person for the new entry, and permits a new entry to be
made into the Contact data base while doing so. This is an example of the buttons in InfoNMT
doing rather more than the basic Filemaker Pro commands. InfoNMT buttons should always be
used where they are provided.
7.3 Extending searches using Filemaker Pro commands
Fig. 7.2 shows the result of pressing Find Call in the Tracking database.

Fig. 7.2 Symbols to extend searching and finding screens in InfoNMT
A screen of entry areas to fill in appears, and a Continue button is supplied by the system in the
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left hand border. It has a double ring around it, meaning that if you hit the enter or return keys
on the keyboard the system will assume that this is the button to be 'pressed'.
Pressing the mouse button over the small arrow on the left hand border will produce a series of
special symbols which can also be used in this search. These symbols extend the searching
facilities of InfoNMT, and are also available in any Search or Find command in InfoNMT. These
symbols can be used to extend the words or numbers typed in each of the fields of the screen to
locate records, and provide a shorthand way of searching for dates or ranges of numbers. For
example, typing in the entry date field: 12/9/94 ...// means find all records where the date is
between the 12th of September 1994 and today.
This feature is valuable when exporting records entered or modified between given dates. This is
the task required when sending updates into a central coordinating location.
As an example of this process of central updating, let us assume that a copy of InfoNMT was
supplied to a specific person on 12/9/94. After two or three months, the person has added several
contacts, extended several data base records, and added several data resources from his own
organisation. It is now time to send these updates into a central point to update the central copy of
InfoNMT. Export of these records is discussed in Section 8.3.

Fig. 7.3 Selecting all entries or amendments made since 12/9/94
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8. DELETING, EXPORTING AND IMPORTING RECORDS
8.1 Saving changes
Filemaker Pro saves new entries or changes to the database as each field is altered. It is also
possible to set it using the Filemaker Pro menu function Preferences to save any changes
continuously in the background, or to do it every few minutes,. Thus if a large entry is being done
what has been added will still be saved even though the user may not yet have left the data field
currently being worked on.
8.2 Deleting records
On some occasions records will need to be deleted. If a record is deleted from InfoNMT it cannot
be recovered, so a reference copy of the InfoNMT files should always be kept separately from
your machine. Deletion of records has been left as a function of the Filemaker Pro menu
commands, as in general deletion is a task which should be needed only rarely in a database of
this kind.
It is very important to realise that if you delete a record, it cannot be recovered. Deletions should
therefore be made only when a backup copy of the database is held in reserve in case the wrong
record is deleted, or the deleted record may be needed at a later time.
Single records can be deleted, or a whole set of records can be selected as a the result of a Find or
Search process and then deleted as a unit using the Delete Found Set command in the FileMaker
Pro menu shown in Fig. 8.1.

I
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Fig. 8.1 Deletion commands in the Edit menu in Filemaker Pro
The menu in Fig. 8.1 is obtained by pressing the mouse button with the cursor over File in the top
line of the video screen.
If all records in the Contact database other than Advocate contacts were to be deleted, then a Find
could be done with Adv. in the Type field of Fig. 4.1 with the Omit button in the left hand border
clicked on. This would select all the contacts other than Adv. If Delete Found Set was then
selected, all of these records currently selected would be deleted at once, leaving only the Adv.
(Advocate) contact records in the database.
8.3 Exporting and Importing records
The easiest way to export data from InfoNMT is to Print the appropriate screen. Special buttons
are provided for all screens where this is expected to occur, and the File menu at the top of the
page (Fig. 8.2) can also be used directly from Filemaker Pro.
Sometimes only a section or part of a record is required. This is readily copied using the Copy
command in the Edit menu (See Fig. 8.1) and Pasted into another program, or on a Mac into the
scrapbook via the clipboard. Exporting the graphics and the sounds stored in the InfoNMT
database must be done this way, as they can not be exported from the database using the Export
command.

Fig. 8.2 Export and Import of records from InfoNMT
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Exporting records obeys the same general rules as deleting records. First Find or Search for a
record or set of records of interest, and then select Export from the two level menu illustrated A
file naming and selection dialogue then appears, and a format for Exporting the records must be
chosen from the box at the bottom of the dialogue. Usually this can be left as the default (Tabseparated), but if tabs have been used in the fields being exported some errors are likely arise
when the records are re-imported.
A name for the exported file must be typed in, and a folder or directory selected for where it
should be written. All of the variables available in the database being exported will then
appear..This list will differ for the three databases that make up InfoNMT.
Importing records via the Import option in the File menu. requires care. This method of bringing
additional files into InfoNMT is not recommended unless the user has experience of this type of
task in other Filemaker Pro Applications .

9. MAINTAINING A CONSOLIDATED COPY OF InfoNMT AT A CENTRAL LOCATION

For maintenance of the resource, it is desirable that updates be added to the InfoNMT master
copy rather than be exchanged between individuals. This section explains how to create a file to
send to update the master copy and, for completeness, also explains the updating process.
9.1 Creating a file of altered or new records
The recommended procedure is as follows:
•

Create a Copy of the relevant data base: either the Contacts database or the Data database.

•

Find all entries up to the date that the database was received by the user.

•

Delete all the records found.

•

Send this modified Copy of the database to the central point for review, assessment and
consolidation.

Use the Filemaker Pro menu at the top of the screen (as in Fig. 9.1) to create a copy of the
complete database by selecting Copy of current file before releasing the mouse button in the
dialogue of Fig. 9.2 which appears after selecting Save a Copy as....
Open this file (which will be called Copy of Contacts.Nsw or Copy of Data.Nsw) and do a Find
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for all records prior to the date you received InfoNMT, or the date you last mailed an update back
to the central coordination point. For the Contacts database the Find button on the front page can
be used.

O
Fig. 9.1 Creating a copy of the current Data or Contacts database
For the Data database, go to the top of the screen under the Select menu and select Find. The
same commands can then be given in the Date of Entry position on the blank copy of the master
screen that will then appear. This menu selection is shown in Fig. 9.2.

Fig. 9.2 Selecting a "Find" from the top menu bar
The screen produced is shown in Fig. 9.3 and the Entry date field " find all records entered or last
amended prior to 12/9/94" . Pressing return or clicking on the Find button in the left hand margin
will then locate all these records.
The Delete Found Set entry on the Edit menu at the top of the screen deletes all these records.
You are then left is the Copy of... file with all of the records entered or updated on or after
12/9/94. This is the file to mail in to the consolidation point.
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Fig. 9.3 Specification of all records entered or last amended prior to 12/9/94
9.2 Importing a file of Contact or Data records in Filemaker Pro format
The central consolidation point will have to review and assess all changed and additional records.
Amendments could then be reviewed, and the master entries changed accordingly. Once the
InfoNMT additions sent in had been assessed and made ready for inclusion, they would then be
added to create an expanded InfoNMT with the new entries included. These new data base
descriptions would then need to be put together into a consolidated file of records to be added to
the master file. A copy of this consolidated updated file could then be sent out periodically to
InfoNMT users.
The new file of InfoNMT records (say "Additions to Data.Nsw") would then need to be read into
the users version of InfoNMT, or preferably a copy to protect against errors in the update process.
This can be done by using the Import entry under the File menu on the menu bar at the top of
the screen and selecting "Additions to Data.Nsw" from the list of files shown in Fig. 9.4.

Fig. 9.4 Selecting and additional set of records to update a copy of InfoNMT
Unfortunately, although the two database sections contain the same fields, they may not be in the
same order. This order changes for a variety of reasons internal to Filemaker Pro as InfoNMT is
used. The task is to ensure that all of the fields shown in bold black on each side are positioned
opposite each other, and that there is a black arrow joining them.
Field names on the right hand side can be moved by clicking on them with the mouse and
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dragging them to the appropriate position. The

marker appears when a field name has been

selected.

Fig. 9.5. Matching the sequence of the fields in the file you wish to import
In Fig. 9.5 the Date of Entry has been selected. The black arrows joining them are drawn by
clicking with the mouse on the dotted line up the middle of the screen. When all of these match
up, and have the back arrows joining them, then click on OK. As these two databases are identical,
clicking on the Match Fields button will automatically carry out both tasks, and produce the
screen shown in Fig. 9.5, even if the order in the two database files are initially different..
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GLOSSARY
Button: is an area on the InfoNMT screen which will cause an action if the mouse is placed over it
and the mouse button clicked at that position. The terms 'click on a button', 'use a button' both
refer to this process.
Database: is an assembly of records each of which has a series of fields which contain
information about the particular item described by that record.
Item: is an individual piece of information held in a record: this might be a first name, a postcode,
or a complete interview.
Record: is an assembly of items of information each of which has a series of fields which contain
information about the particular item. For example a full set of name, address, organisation etc
would comprise a record made up of the name etc as individual items.
Screen: this term is used in two ways. To describe the complete video screen display (which
includes Filemaker Pro menus as well as the InfoNMT display), and also the InfoNMT screen,
which is a display inside a bordered widow with the NMT title (Contacts, Tracking etc) as part of
the top outline area)
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APPENDIX 1 INSTALLING InfoNMT ON AN IBM PC COMPATIBLE COMPUTER
Filemaker Pro should be installed on your machine before installing the InfoNMT files from the
archive discs supplied.
InfoNMT is supplied on a series of discs in an archive format using PKZIP version 2.04. The
InfoNMT files have been compressed onto two 1.4 mb discs.
A1.1 How the multi-floppy installation archive INMTDB.ZIP is created
The Shareware program PKZIP version 2.04 was used to compress all the InfoNMT files onto a
series of floppy discs, using the -&v option to create a single compressed archive of all the
InfoNMT files over a series of discs. These discs are named PKBACK#001, PKBACK#002 etc.
The shareware release 2.04 of PKZIP and PKUNZIP is included on the last disc of this series. It
may be provided to any party as long as no charge is made and all of the files in the PKZIP
directory are provided together. PKUNZIP runs under DOS, and it is sensible to exit from
Windows to run it. The files supplied in the in the PKZIP/PKUNZIP shareware package are listed
below.
PKUNZIP
PKUNZJR
PKZIP
PKZIPFIX
4 File(s)

EXE
COM
EXE
EXE

29378
2750
42166
7687

5-08-95
5-08-95
5-08-95
5-08-95

4:57p
4:57p
4:57p
4:57p

2682880 bytes free

Fig. A1 The files comprising the PKZIP Shareware package
InfoNMT was compressed using the command PKZIP -&V INMTDB *.NBS
The archive INMTDB.ZIP begins on disc PKBACK#001, and continues over the following discs
in the set supplied.
A1.2 Verifying the integrity of an InfoNMT multi-floppy disc archive.
First create an InfoNMT directory on your hard disc for the InfoNMT data files.
Copy PKUNZIP.EXE from the last disc in the IBM InfoNMT package to this directory
To ensure that the compressed copy of InfoNMT is fully reliable , place the first disc in the
InfoNMT IBM floppy disc release set in floppy disc drive A:, and type PKUNZIP -T
A:INMTDBDB.ZIP. If your 3.5" floppy disc drive is drive B:, type
PKUNZIP -T B:INMTDB.ZIP
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These settings for PKUNZIP will systematically verify that this copy of the InfoNMT archive is in
good condition, before expanding it onto a hard disc.
If the archive is reported to be faulty, contact the suppliers of your installation archive discs for a
replacement set.
A1.3 Installing InfoNMT from a multi-floppy disc archive.
PKUNZIP.EXE is also the program which unpacks the file stored on the set of discs supplied.
There are a number of options built into PKUNZIP, and these may be seen by typing:
PKUNZIP <ENTER> without any arguments (Fig. A2).

PKZIP (R)
FAST!
Create/Update Utility
Version 2.04g
02-01-93
Copr. 1989-1993 PKWARE Inc. All Rights Reserved. Shareware Version
PKZIP Reg. U.S. Pat. and Tm. Off.
Patent No. 5,051,745

PKZIP /h[1] for basic help

Usage:

PKZIP /h[2|3|4] for other help screens.

PKZIP [options] zipfile [@list] [files...]

Simple Usage:

PKZIP zipfile file(s)...
|
|
|
Program ----------------|
|
|
|
New zipfile to create ---------|
|
File(s) you wish to compress ---------The above usage is only a very basic example of PKZIP's capability.

Press 2 for more options (including spanning & formatting), press 3 for
advanced options, 4 for trouble shooting options, any other key to quit
help.

Fig. A2 PKZIP default help file
The command used to install from floppies in drive A: is:
PKUNZIP -EN A:INMTDB.ZIP
This specifies that the files are to be unpacked, and if files of the same date are already installed
they will not be copied over the top of the ones already installed.
PKUNZIP Reg. U.S. Pat. and Tm. Off.
Usage:

PKUNZIP [options] zipfile [@list] [files...]

-c[m]
extract files to Console [with More]
-d
restore/create Directory structure stored in .ZIP file
-e[c|d|e|n|p|r|s] Extract files. Sort by [CRC | Date | Extension | Name
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| Percentage | Reverse | Size]
-f
Freshen files in destination directory
-j|J<h,r,s>
mask|don't mask <Hidden/System/Readonly> files (def.=jhrs)
-n
extract only Newer files
-o
Overwrite previously existing files
-p[a/b][c][#]
extract to Printer [Asc mode,Bin mode,Com port] [port #]
-q
Enable ANSI comments
-s[pwd]
Decrypt with password [If no pwd is given, prompt for pwd]
-t
Test .ZIP file integrity
-v[b][r][m][t]
View .ZIP [Brief][Reverse][More][Technical] sort by [CRC|
[c,d,e,n,o,p,s] Date|Extension|Name|natural
Order(default)|Percentage|Size]
-x<filespec>
eXclude file(s) from extraction
-$
Restore volume label on destination drive
-@listfile
Generate list file
Press 2 for advanced/trouble shooting options.
Press any other key to quit help.

Fig. A3 The help file for PKUNZIP.EXE
Fig. A3 summarises the help built into PKUNZIP.EXE. Switch E specifies that the InfoNMT files
are to extracted, and switch N ensures that, if InfoNMT is already installed, PKUNZIP will install
only versions of the files that are more recent than those already on your hard disc. If the set of
InfoNMT discs contains any files dated the same as those you have currently installed, it will not
install a new copy. However, as Filemaker Pro updates the date for each file that it accesses, the
dates on your hard disc and on the InfoNMT Filemaker Pro release files will only correspond
when something has gone wrong during the installation process, or if some file in InfoNMT has
not been used since it was installed.
C:\PKZIP>pkunzip -en inmtdb.zip
PKUNZIP (R)
FAST!
Extract Utility
Version 2.04g 02-01-93
Copr. 1989-1993 PKWARE Inc. All Rights Reserved. Shareware Version
PKUNZIP Reg. U.S. Pat. and Tm. Off.
˛ XMS version 3.00 detected.
Searching ZIP: INMTDB.ZIP
Inflating: CONTACTS.NSW
Inflating: DATA.NSW
Inflating: TRACKING.NSW

Fig. A4 Example of the process of installing InfoNMT
Fig. A4 is an example which shows how PKUNZIP prompts the user to ensure that the correct
discs are inserted at the correct time as the installation proceeds.
When PKUNZIP has finished reading and expanding the INMTDB.ZIP file on the set of disc
supplied, all of the files will then be installed in your InfoNMT directory. They will be of two
types.
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• Filemaker Pro files with a suffix of .NSW
To run InfoNMT, start the FileMaker Pro program by double clicking on the FMPRO icon, and
open the file CONTACTS.NSW to start work using InfoNMT .
For those with a good knowledge of Windows, it is possible to associate the three .NSW files with
the Filemaker Pro program so that double clicking on any of them will automatically request
Windows to start up Filemaker Pro and open the appropriate .NSW file.
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APPENDIX 2. INSTALLING InfoNMT ON AN APPLE MACINTOSH COMPUTER
Filemaker Pro and Endnote Plus should be installed on your machine before installing the
InfoNMT files from the archive discs supplied.
InfoNMT is supplied on a series of discs in a self extracting archive format using Compact Pro
version 1.51. The InfoNMT files have been compressed onto three 1.4 mb discs. The third disc
also contains a copy of Compact Pro 1.51 shareware in a self-extracting format.
A2.1 Installation of InfoNMT using only the self extracting archive
To install the InfoNMT files, place the first floppy disc in the set in a floppy disc drive, and
double click on the inmtdb.sea icon. Inserting the first disc in the series will show:

\
Fig. A5 First disc in the InfoNMT archive set
This icon shows that the archive was created by Compact Pro, and is a self expanding file. Double
clicking on this icon will produce the following dialog:

Fig. A6 Dialog in response to double clicking on the icon in Fig. A5
Use the buttons on the right hand side of this dialog to eject the first disk, and to Load the
segment inmtdb.sea #5 which resides on the fifth and last disc in the InfoNMT set.
As soon as this segment is loaded, the InfoNMT installer offers a brief note (Fig. A7) specifying
the files which will be extracted.
It will then ask for the Folder into which the files are to be expanded, and, if there is room, will
then proceed to expand all these files and place them in that folder.
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Fig. A7 Specification of the files which will extracted from the InfoNMT archive
A2.2 Selective installation using a copy of Compact Pro 1.51 or later
Insert the last of the set of InfoNMT archive discs and double click on the Compact Pro.sea icon.
This will open a dialog asking you where to install Compact Pro, and you can then direct it to be
installed on your hard disc.
Double click on Compact Pro itself and open the InfoNMT archive will be displayed (Fig. A8).
The expanded InfoNMT Pre-Release1 files can be seen to require 5 Mb.

Fig. A8 Contents of the InfoNMT inmtdb.sea archive

Fig. A9 Selecting a file (or files) from the InfoNMT archive to extract.

1 The

ANBI 1.0 Release may be larger. Check the size of the files using the instructions in this Appendix before
installing ANBi to ensure that you have adequate room on your hard disc.
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Using the Compact Pro program to do the installation or updating of a copy of InfoNMT allows
you to select which files you wish to extract, and offers the choice of destination folder for each
set extracted. Fig. A9 shows how this is done.
Clicking on the "name" button

will show the following message (Fig. A10)

confirming the contents of the archive.

Fig. A10 InfoNMT archive annotations
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CREDITS

A screen of this format in each database summarises the project sponsors, the InfoNMT Project
Steering Committee and the project team.
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Safety, 17
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Interviews with Contacts, 20
Item, 32
Labels, 21, 22
Layout, 13
Letter, 21
Letters, 21
List, 19
List Layout, 10
Listing of Contacts, 19
Location Screen, 15
Mailing Aids, 21
maintenance, 28
Match Fields, 31

NMT-94-R6

Microsoft Windows, 1
Move, 24
New Contact, 24
New Record, 24
Notes, 5
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Organisation, 20
Pasted, 27
Policy Screen, 17
Potential Screen, 17
Preferences, 26
Preview, 13
Print, 21, 27
Quit InfoNMT, 7
Record, 32
Records Screen, 14
Reference specifications, 1
References Screen, 15
RefNMT, 8
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Return to Contacts, 5, 11
Runtime only versions, 3
Saving changes, 25
Screen, 32
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Search Screen, 17
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System requirements, 3
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Usage Screen, 14
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InfoNMT Feedback Page
Please Fax a copy of this page to 02 550 4013
Non-Motorised Transport Project,
Institute of Transport Studies, University of Sydney
An information resource is only as good as its users find it. Feedback from users can help to
improve the design and content of InfoNMT, and this page has been provided to make this
easier to do. Handwritten comments are welcome.

InfoNMT
Feedback

What would you like to
see added?

What would you like to
see changed?

This Manual

The Contact and
Tracking
databases

The Data database

Any other comments

Signed.....................................
Tel..........................................

Fax......................................
EMail...................................
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